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Introduc�on to LiDAR using ArcGIS 
Pro: Part A 
A R C G I S  P R O  V E R S I O N  2 . 3

In this guided tour you  
will be using ArcGIS Pro to: 

• Import LAS files into an ArcGIS LAS Dataset
• View the LiDAR Point Cloud and change the symbology
• Colorizing the LAS Dataset with Digital Orthophotography
• View in 2D and 3D

Introduction 

What is LiDAR?  LiDAR stands for Light Detec�on and Ranging. LiDAR data provides high levels of detail 
and precision in describing eleva�on.  Products derived from LiDAR include such things as very accurate 
eleva�on models as well as surface height informa�on for such things as building and trees.   

In this training tutorial will be using publicly available LiDAR data for an area in Arroyo Seco, New 
Mexico. In Part A you will be using ArcGIS Pro to introduce you to the LAS Dataset and view LiDAR point 
clouds in both 2D and 3D. In Part B you will further explore how to create a Digital Eleva�on Model 
(DEM), a Digital Surface Model (DSM), calculate absolute heights, and create a vegeta�on density 
model. 

Time to complete 
Approximately 60 minutes 
Requirements: An Internet connection, 
ArcGIS Pro v. 2.3 with Spatial Analyst and  
3D Analyst Extensions Watershed Boundaries in the US
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Let’s Get Started 

In this first sec�on, we will introduce you to ArcGIS Pro and will explore 2016 LiDAR data collected in 
Taos County New Mexico near the town of Arroyo Seco.  You will learn how to use ArcGIS Pro to create 
a LAS Dataset and view and display LiDAR data.  

Open ArcPro and Login using provided login information 

To open ArcPro, go the Windows Start Menu.  Go To ArcGIS and use the dropdown menu to see all of 
the programs.  When you see ArcGIS Pro  

double click to open the program. 

Once you open ArcGIS Pro you will need to sign into an ArcGIS 
Online account.   For this exercise you will be provided with a 
temporary Username and Password, enter this informa�on 
provided by your instructor. Your instructor will provide these 
details before this lab begins.    

* This is a temporary account �ed to Highlands.  Back in your office you will need
to create an ArcGIS Online account that is linked to your licensing account to fully
access ArcGIS Pro at your work computer.

 Step I. Create a New Project and a LAS Dataset  

Once you have signed in, ArcGIS Pro will 
prompt you to create a new project. Under 
NEW, Blank Templates Click on MAP  
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Another window will open 
where you will enter the 
name of the new project 
and its loca�on on your 
computer.   

1. Enter the Name as
ArroyoSeco_Data
For Loca�on, click on the folder icon to browse to this loca�on your computer
C:\students\Exercise_Data
Be sure to UNCHECK the box next to create a new folder for this project and the click OK.

 ArcPro will then open to your project Catalog page. 

2. Click on the  ‘Folders’
icon from the Project
Catalog window.
Next,  open the
Exercise_Data folder

3. With the
Exercise_Data folder
selected, right click
and Select New > New
LAS Dataset.
This will create a LAS
Dataset, which is a
container to hold .las
files so that we can use
them in ArcGIS Pro.

4. Name the new LAS
Dataset file
ArroyoSeco.lasd
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5. Next, Right click on the newly created ArroyoSeco.lasd and click on Proper�es.

6. This will open the LAS Dataset Proper�es.  Click on the tab on the le� LAS File and then click on
the buton to Add Files.

7. Now you can browse to where your .las files is located on your hard drive.
Go to: /students/Exercise_Data/      and select 13SDA515410.lasd

8. Before clicking OK, con�nue looking at your LAS Dataset proper�es and you will now see your 

LAS File loaded.  Click on the le� hand Sta�s�cs Tab and click on the Calculate buton.

This will calculate the sta�s�cs for the LiDAR file so now you will see more informa�on about 

your LiDAR data.  Within that same Sta�s�cs window One at a �me, click on the Classifica�on 

Codes, Atributes, Returns, and Classifica�on Flags to get more informa�on about your data.

9. Answer these ques�ons with while looking at the LAS Dataset proper�es:

Question A:  What is the point count of your 1st returns and what percentage does this 

make up of the total returns?   
1st Return Point Count ___________________________________ 

Percent of Total ________________________________________ 

Question B:  What is the Projection of your LAS Data?  
Current X,Y Coordinate System(2D) _________________________________________ 

Current Z Coordinate System(3D) ___________________________________________ 

What are the coordinate units?    Circle the correct answer:   Meters    Feet    Inches 

Question C:  What is the Point Spacing of your LAS Data?   
Point Spacing   _________________________________________ 

10. Now click the OK buton to close the LAS Proper�es window.
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Step 2.   Add your LAS Dataset to a map and view your LiDAR data     
 

1. Close the LAS Dataset Proper�es window by clicking OK at the botom of the window. 
 

2. This will take you back to the 
Catalog window.  Right Click on 
your ArroyoSeco.lasd file and  
then click on  Add to Current 
Map  
 

3. This will add your LiDAR data 
to your open Map. You will 
only see a red box iden�fying 
the extent of your LiDAR data.  
  
Using the Roller Ball on your mouse roll it away from you to zoom in un�l you start to see you 
LiDAR Points.  
 
 Alterna�vely, you can use the naviga�onal tools from the 
MAP menu bar to zoom in and zoom out (arrows poin�ng in 
and poin�ng out).  To get to your last extent use the blue 
arrows.  To see the full extent of your data click on the globe 
icon.  
 

4. Now that you can see the LiDAR points, look at the top of your window and you should see  
LAS Dataset Layer highlighted.  The LAS Dataset Layer provide commands and tools specific to 
LiDAR datasets.  Three func�ons appear underneath; Appearance, Data, Classifica�on.   
 
Click on the Appearance Tab.  You 
can now change the appearance of 
your LiDAR data.   
 

 
 
Under the Point Thinning click on the slider tool going from 
Density Min – Max.  No�ce the point cloud differences when 
you increase and decrease the point density.   
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5. Next click     

on the Symbology tab 

  

 
Your LiDAR point cloud default view is Eleva�on.  You will also see a menu appear in the right side of 
your map which provides more detail on how your data are displayed. You can view your point cloud as 
Points, Lines or Rasters.   

6.  Take a few minutes to view your points by 
Eleva�on values.  No�ce that the Values range from 
2453 to 2833.   
These values are listed in the same units as the 
LiDAR’s coordinate system.  Look back to Ques�on B.  
Are the eleva�on values in Meters or Feet?   
 
You can change the symbol scale (Size of points), the 
color scheme, and the Stretch (How your data are 
grouped sta�s�cally).  
 
7. Let’s look at other ways to view your point cloud. 

Under Points > Draw Using 
 
Click alterna�vely on these op�ons:  
Eleva�on (classified), Intensity, 
Classifica�on, Return Number, Number of 
Return.   
       

Take �me to look at the results and change the se�ngs for each to see how your LiDAR data can 
be displayed in different ways.   
 

A. Eleva�on – shows eleva�on values high to low in the units of your data (in this case meters).  
Eleva�on Classified allows you to classify your eleva�on ranges.  You can also set breakpoints 
to Classify areas higher or lower than a set eleva�on. 

Change the number of classes and see the results.   
 
 

B. Intensity –Displays the intensity of the return signal.  Buildings will have a different intensity 
values comparted to natural features such as grass and trees.  No�ce where intensity values 



Introduc�on to LiDAR using ArcGIS Pro: Part A 

 

Page 7 

are higher or lower.  (Hint - areas with a lot of texture have lower intensity values as it scaters 
the laser pulse when it hits the ground).   

 
To view imagery for this area, go back to the Map Tab and add Basemap  and select 
Imagery. To return to your LiDAR symbology click on LAS Dataset Layer > Appearance 
 
*Note uncheck (turn off) your World Imagery layer when not needing it as it will slow 
down your display refresh rate.   
  

  
 
 
 
 
 

 

C. Classifica�on - reflects how the Lidar points are classified.  With this dataset there are only 
two classes, Unassigned (1) and Ground class (2).  

D. Return Number –Displays the return number of each LiDAR laser pulse.  First Return 
represents the first loca�on that the laser pulse hits.  Second through Fourth returns are 
intermediate returns, (ie points hi�ng through the tree canopy) Last return is not always the 
ground, it is simply the last place the laser hits before return back to the sensor.  This can be 
hard to see as mul�ple returns may be underneath. 

E. Number of Returns -  This displays were the mul�ple returns are versus single returns. 

 
7.  You can also see more informa�on about the point cloud by 
clicking on individual points.  Zoom into an area with your LiDAR 
Data so you can see individual points.  
 
Use your mouse cursor and click on a point of the point cloud.   

 
The pop-up window will provide the raw informa�on associated 
with that point.  The Z value is the eleva�on.  No�ce it gives 
La�tude and Longitude for the coordinate but then at the botom 
you see the coordinates in Northing/Eas�ng in UTM 
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8 Now let’s view the LiDAR data symbolized as Contour 

Lines.   
Go Back to your Symbology menu. 
 
Click on the contour icon and then check Draw 
Contours.  The contour intervals are in the same 
units as the LiDAR data (meters).  Now look at your 
map, the contours are drawn on top of your point 
cloud.   
 
To see your contours beter turn off your point cloud. 
Click on your Points 
icon and then 
uncheck the box 
next to ‘Draw using’  
 
 
 
 
 

9  Now look at your contours.  Does anything seem strange?  Do you see eleva�on contours 
around the trees and buildings?  This is due to the fact that it is symbolizing all of your point 
cloud  - even points on the surface such as trees and buildings.  To get a beter idea of what is 
only on the ground, let’s only create contours from ground points.   
 Go to the top menu and select LAS Dataset Layer > Appearance.  Then Click on the black arrow 
next to the LAS Points buton and click on Ground Points.  This filter tool will now only display 
points that are classified as Ground.  
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10 If you have your contours s�ll turned on they will automa�cally update to only show contours 
using ground points (No�ce the contours in the trees are no longer there).  Change the contour 
interval from 5 to 2 and see what happens.   
 
*NOTE – If your LAS Dataset Layer tools disappears from your top menu.  Go to your table of 
contents and click on ArroyoSeco.lasd , now your LAS Dataset Layer menu will appear.   
ArcPro is selec�ve in the tools it displays so your window is not full of so many commands.  
 

11 Finally you will symbolize your LiDAR data using an interpolated Raster Surface. 
 
Go back to Symbology and with the Contours 
op�on open, uncheck Draw Contours so it is no 
longer displayed in your map.  Now go back to 
the Symbology menu and click on Surface.  
 

a. Go through each of the surface op�ons: 
Eleva�on, Slope (Percent Slope), Aspect 

b. You can change the number of classes 
and the color scheme as you would like. 
 
 
 
 

12 Before we move 
on to our next 
sec�on be sure 
uncheck the Raster 
display. 

 

 

13  Now turn on the point 
cloud using Eleva�on 
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14 Remove the ground filter as you will want to be viewing all off the point cloud, not just the 
points classified as Ground.   
 
Go to LAS Dataset Layer > Appearance > LAS Points > and using the dropdown arrow click on 
All Points 
 
  

 

 

 

 

  

 

 

Step 3.   Colorize your LiDAR point clouds using Aerial Imagery  

 

So far you have changed the appearance of the LiDAR point cloud based its atributes such as eleva�on, 
return number, etc.  Now you are going to add the RGB color values of a 2016 NAIP image to the Point 
Cloud.  Using this informa�on from Aerial Imagery, you can provide an immersive, photorealis�c display 
with your LiDAR data. 

1. To run this tool, you need to go to the top menu and click on Analysis > Tools  
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When you click on the Tools Icon it will open the 
Geoprocessing Pane, Be sure to click on the Toolboxes 
Tab. 

Within Toolboxes, to open the tool you need, click in 
this order: 
3D Analyst Tools > Data Management >  
LAS Dataset > Colorize LAS 

Be sure to double click on Colorize LAS to open the 
tool. 

*Note you can also Type ‘Coloraize LAS’ in the box 
where is says Find Tools  
to search for the command.  

 
 

With the Colorize LAS tool open, enter the following 
informa�on:  

1. Use the drop down arrow to select 
your file ArroyoSeco.lasd 
 

2.  Click on the Folder icon to browse to  
C:\student\Exercise_Data 
and select the file:  ortho2016.img 
 

3. Use the drop down arrows to select 
LAS Channel as Red, Green, Blue and 
Image Band Layer_1, Layer_2, Layer3 
 

4. Browse to your target folder: 
C:\student\Exercise_Data 

 
5. Type in your file name: 

ArroyoSeco_RGB.lasd 
6. Click on RUN at the botom to run the 

command.  
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It will take a few minutes to run, once it is finished it will appear in your table of contents.   

7. Turn off your Arroyo Seco.lasd so that the ArroyoSeco_RGB.lasd is the only point cloud. 
8. Turn off your basemap if necessary to see the colorized point cloud.   
9. Zoom out to see your point cloud as it will zoom you in too far  

 
 

10. You will not see it displayed as the symbology 
defaults to Eleva�on  
so go back to LAS Dataset Layer > Appearance > 
Symbology.  

 

From the drop down menu select 
Draw Using RGB 

 

 

 

 

 

To get the point density and point size  
the way you would like it,  
if needed adjust the density slider.    

 

 

Also adjust the Symbol Scale slider unit the point size is appropriate.  
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Step 3.   View your Colorized LiDAR data in 3D 

To get a beter visualiza�on of our LiDAR display we will now convert our map display from 2D 
to 3D. 
 
1.  From the top menu click on  

View > Convert > To Local 
Scene  
It will take a minute to convert 
your display to 3D.   
 
Then zoom out to see your 
point cloud.  

 
 
 
 
 
 
2. At the botom le� corner of your map you will see the Navigator Tool, click on the arrow to 

get the full use of the tool.  By clicking on the blue circle you can change the ver�cal 
perspec�ve.  

 

 Spend some �me zooming around your display.  It takes some trial and 
error to get this to work. 

  
   
  

 

 

 

 

 

 



Introduc�on to LiDAR using ArcGIS Pro: Part A 

 

Page 14 

 

 

 

 

3. To go back to your 
2D view, clicking on 
your Map Tab.   

You can close your Map 
3D tab by clicking on 
the X. 

 

 

 

 

 

 

 

 

 

 

 
4.  Your very last step is to save your project. 
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This is the end of Exercise Part A.  

 
Other LiDAR Links / Tools 
 
If you have finished the exercise and there s�ll 
�me, look at these online tools to learn more 
about LiDAR 

USGS 3DEP Viewer 

This viewer was developed to display USGS 
DEM derived products from LiDAR via the 
USGS 3D Eleva�on Program (3DEP).  
 
To open the viewer go to:  
htps://apps.na�onalmap.gov/3depdem/ 

Type in a few loca�ons that you are familiar with to see these different LiDAR derived products.   

The USGS 3D eleva�on program is an ini�a�ve to gather na�onwide LiDAR data by 2023. This new 
eleva�on map service introduced by USGS allows users to create mul�-resolu�on visualiza�ons on 
demand, including automated contours, hillshade, aspect, slope, and �nted hillshade.  
Users can generate DEMs at a mixture of scales, down to 1 meter.  For more informa�on on the USGS 
3DEP program visit:   
htps://www.usgs.gov/core-science-
systems/ngp/3dep 

 
The National Map : TNM 
Download for LiDAR Data 
To download LiDAR data for areas 
across the Unites States go to:  

htps://viewer.na�onalmap.gov/basic/ 

Select Eleva�on Source Data 3DEP 

*Please don’t download data on Lab 
Computers but just look at how the 
process works.  

https://apps.nationalmap.gov/3depdem/
https://www.usgs.gov/core-science-systems/ngp/3dep
https://www.usgs.gov/core-science-systems/ngp/3dep
https://viewer.nationalmap.gov/basic/
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Lidar Derived Products: Part B 
 
U S I N G  A R C G I S  P R O  V E R S I O N  2 . 3  

 

Outcomes for the lab 

In this lab, you will use LiDAR data in ArcGIS Pro to: 
 

1. Classify Buildings 
2. Create LiDAR Products: 

a) Bare Earth Digital Earth Model (DEM) 
b) Digital Surface Model (DSM) 
c) Hillshade  
d) Slope  
e) Aspect  
f) Contour  

3. Calculate Vegetation Height  
4. Calculate Canopy Density 
5. Design a Map  

 

 

 

 

 

Time to complete 
Approximately 2.5 hours 
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Introduction 

 
Let’s Get Started 
Open ArcGIS Pro. Open the Project: ArroyoSeco_Data.aprx.  

On the le� side of the browser under Open  Recent Projects click ArroyoSeco_Data. 

 

 

Part 1. Classifying Buildings 

Every lidar point can have a classifica�on assigned to it that defines the type of object that has reflected 
the laser pulse. Lidar points can be classified into a number of categories, including bare earth or 
ground, top of canopy, and water. The different classes are defined using numeric integer codes in the 
LAS files. 

Lidar points stored in LAS files are typically classified into different categories using specialized 
classifica�on tools outside of ArcGIS. This classifica�on is usually completed by se�ng parameters 
based on the terrain, and then running algorithms on the point cloud to determine the feature type 
associated with each point. The classifica�on code assigned to each point is writen to the LAS file and, 
in most cases, adheres to the ASPRS standard. 

TABLE 1: ASPRS LAS CLASSIFICATION CODES 

Classifica�on Value Meaning Classifica�on Value Meaning 
0 Never Classified 11 Road Surface 
1 Unassigned 12 Reserved * 
2 Ground 13 Wire – Guard (Shield) 
3 Low Vegeta�on 14 Wire – Conductor (Phase) 
4 Medium Vegeta�on 15 Transmission Tower 
5 High Vegeta�on 16 Wire-Structure Connector (Insulator) 
6 Building  17 Bridge Deck 
7 Low Point 18 High Noise 
8 Reserved * 19-63 Reserved 
9 Water 64-255 User Definable 
10 Rail   
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When a classifica�on is carried out on LiDAR data, points may fall into more than one category of the 
classifica�on. Classifica�on flags are used to provide a secondary descrip�on or classifica�on for lidar 
points. In later versions (LAS 1.1 and later), class flags were used to solve this problem. Classifica�on 
flags were added to the LAS standard to mark points with informa�on addi�onal to the tradi�onal 
classifica�on. Synthe�c, key-point, withheld, and overlap flags can be set for each LiDAR point. These 
flags can be set along with the classifica�on codes. For example, a water record could be given a 
classifica�on code for water (9), as well as a withheld flag. The point will remain in the dataset but will 
be withheld from any addi�onal analysis on the LAS files. 

In many cases, LAS files may not be fully or correctly classified when introduced to the GIS tools in 
ArcGIS. ArcGIS provides the LAS dataset and associated tools to enable classifica�on or data cleanup of 
classifica�on codes and classifica�on flags residing in the LAS files. 

Interac�ve and geoprocessing tools provide the ability to edit classifica�on codes present in the LAS 
file. The Classifica�on tab for a LAS dataset provides interac�ve edi�ng capabili�es as well as 
automated edi�ng by opening the appropriate geoprocessing tool associated with the analysis. 

The ArroyoSeco LAS Dataset is classified into just two codes: Unassigned and Ground. In this part of the 
exercise, you will add one more classifica�on: Buildings.  

Classifying the buildings will allow you to easily pull out the non-natural features from the landscape 
and withhold them from vegeta�on analysis. With this exercise you will use a shapefile of the buildings 
in Arroyo Seco to classify the LAS Dataset. The shapefile is a subset of a much larger dataset that was 
developed by Microsoft Bing which includes building footprints for the entire United States. 

1) In the catalog pane on the right, browse to the exercise data folder and right click 
‘arroyoseco_buildings.shp’.  Select “Add to Current Map”. You will now see a polygon feature 
class of the footprints of all the buildings within the LiDAR �le.  Add an air photo to see the 
actual loca�ons of the buildings (in the Catalog pane, right click on ortho2016.img, select “add 
to current map”). Within the Contents pane, toggle on and off the buildings shapefile to 
compare the shapefile footprints to the aerial imagery of the buildings. 

 

2) Next, go to the Analysis tab. Click Tools. In the right pane, type “Set LAS Codes Using Features” 
into the search bar at the top of the geoprocessing pane. 
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3) Click the first result that appears –  
“Set LAS Class Codes Using Features” 

4) Under Input LAS Dataset choose 
ArroyoSeco.lasd from the dropdown menu 

5) Under Features choose 
arroyoseco_buildings.shp from the dropdown 
menu 

6) Under the New Class field select 6 from the 
dropdown menu. If you recall from Table 1: 
ASPRS classifica�on codes, 6 is the code used 
for buildings. 

7) Check the box to Compute Sta�s�cs. 
8) Click Run at the botom of the pane. 

Now click on the top of the LAS Points buton in the Filters sec�on of the Appearance Tab.  

You will now see that the building classifica�on code 
has been added to the ArroyoSeco LAS Dataset.  

 

 

 

To view the data you just classified: 

9) Go to the Symbology pane.  
  
 
 
 

10) From the drop down menu 
change Draw Using to 
Classifica�on.  
 
 

 

 
11) If you have any aerial imagery in your map, toggle it off in the Contents pane. Toggle off any 

other layers, such as the buildings shapefile. The LAS Dataset should be the only viewable layer. 
 



Lidar Derived Products: Part B 

 

Page 5 

 

12) On the View Tab, click Convert, to Local Scene 

A new 3D Scene tab will be created so that you can view the 
classified LAS Dataset in 3D. Zoom out and around. Note the 
Building points in pink. Feel free to change toggle on the 
Ortho2016 aerial imagery in the Contents pane order to see 
the buildings on the air photo. Change the symbol scale and 
density if you would like. 

 

 

13) When you are done viewing 
the map in 3D, close the 3D 
map and return to the  
2D map (by clicking the X) 
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Part 2. Create LiDAR Products 
In this sec�on you will produce deriva�ve data from the LAS Dataset. Using geoprocessing tools in 
ArcGIS Pro, you will create a bare earth model, digital surface model, hillshades, and slope, aspect, and 
contour maps.  LiDAR provides you with the opportunity to make high-quality eleva�on models of two 
dis�nct types: first return and ground. A first return surface includes tree canopy and buildings and is 
o�en referred to as a digital surface model (DSM). The ground, or bare earth, contains only the 
topography and is frequently called a digital eleva�on model (DEM). Once you have created these two 
data sets, you can use them to develop other products, such as 3D hillshades, aspect and slope 
datasets, and contour lines. 

A) Bare Earth Model or Digital Elevation Model (DEM)  
To create the DEM or Bare Earth Model: 

1) In the Contents pane on the le�, right click on ArroyoSeco.lasd. 
 

2) Scroll down to LAS Filters. Select “Ground”.  This will filter the LAS Dataset input so that only 
ground points are included in the digital eleva�on model. 

 
 
 

3) In the geoprocessing pane, on the right side of your browser, click the back arrow buton to 
return to the search bar. Type “LAS Dataset to Raster” in the Find Tools search bar. 
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4) Click LAS Dataset to Raster to open the tool 
5) Under Input LAS Dataset choose 

ArroyoSeco.lasd from the drop down menu  
6) Change the name of the output file to 

ArroyoSeco_DEM. Keep the Output loca�on 
the same (inside the ArroyoSeco_data 
geodatabase) 

7) Change the Sampling Type cell size to 1 
8) Click Run at the botom of the pane. 

 
 
 
 
 
 
 

The DEM raster will appear in the Map window 
once the file is processed.  
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B) Digital Surface Model (DSM)  
To create the DSM: 

1) In the Contents pane on the le�, right click on 
ArroyoSeco.lasd. 

2) Scroll down to LAS Filters. Select “1st Return”. 
This will filter the LAS Dataset so that only 1st 
return points are included in the digital 
surface model. 

3) In the geoprocessing pane, on the right side of 
your browser, click the back arrow to return to 
the search bar page. Type “LAS Dataset to 
Raster” in the Find Tools search bar. 

4) Click LAS Dataset to Raster to open the tool 
5) Under Input LAS Dataset choose 

ArroyoSeco.lasd from the drop down menu  
6) Change the name of the output file to  

ArroyoSeco_DSM. Keep the Output loca�on the 
same (inside the ArroyoSeco_data geodatabase) 

7) Change the Sampling Type cell size to 1 
8) Click Run at the botom of the pane. 

The DSM raster will appear in the Map window once the 
file is processed. 

In the Contents pane on the le�, toggle the 
ArroyoSeco_DSM file on and off so that you can 
compare it to the ArroyoSeco_DEM image. 
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C) Hillshades 
To create 3D hillshades of the DEM and DSM 
raster files you just created: 

1) In the geoprocessing pane, click the back 
arrow to return to the search bar page.  
Type “Hillshade” into the Find Tools search 
bar. 

2) Click the Hillshade (3D Analyst) tool to 
open it 

3) Under Input Raster select 
ArroyoSeco_DEM 

4) Rename the output raster to 
“ArroyoSeco_DEM_hs” 

5) Click Run 
6) Repeat the above steps to make a 

hillshade out of the DSM. Name the DSM 
hillshade “ArroyoSeco_DSM_hs” 

In the Contents pane on the le�, toggle the DSM 
hillshade on and off to compare it to the DEM 
hillshade. 

 

FIGURE 1- DEM HILLSHADE    

 

FIGURE 2- DSM HILLSHADE 
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D) Slope 
To create a slope map: 

1) In the geoprocessing pane, click the back 
arrow to return to the search bar. Type 
“Slope” into the Find Tools search bar. 

2) Click the Slope (3D Analyst) tool to open it 
3) Under Input Raster select 

ArroyoSeco_DEM 
4) Rename the output raster to 

“ArroyoSeco_slope” 
5) Leave the Output Measurement as Degree 
6) Change the Method to Geodesic. 
7) Click Run 

The Slope raster will appear in the Map window once the file is processed.  

 

 

E) Aspect 
To create an aspect map: 

1) In the geoprocessing pane, click the 
back arrow to return to the search 
bar. Type “Aspect” into the Find Tools 
search bar. 

2) Click the Aspect (3D Analyst) tool to 
open it 
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3) Under Input Raster select ArroyoSeco_DEM 
4) Rename the output raster to “ArroyoSeco_aspect” 
5) Click Run 

The Aspect raster will appear in the Map window once the file is processed. 

 

F) Contour 
To create a feature class with eleva�on contour 
lines, like those that appear on topographic 
maps: 

1) In the geoprocessing pane, click the 
back arrow to return to the search bar, 
type “Contour” into the Find Tools 
search bar. 

2) Click the Contour (3D Analyst) tool to 
open it 

3) Under Input Raster select 
ArroyoSeco_DEM 

4) Rename the output feature class to 
“ArroyoSeco_contour” 

5) Enter ‘10’ for the contour interval 
6) Click Run 

The contour line feature class will appear in the Map window once the file is processed. 

7) Turn off the other layers by unchecking the boxes next to the layers in the Contents pane 
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8) Click on a contour line – a pop up will 
appear with the atributes for the line including the 
eleva�on (in meters). 

 

 

 

 

9) Before beginning the next sec�on remove the contour, 
aspect, slope, arroyoseco_buildings and hillshade 
layers from your map.  
In the Contents pane, right click on the layer and 
select Remove. When you are done removing layers, 
you should just have the DSM, DEM and LAS Dataset 
remaining in your map. 

 

Part 3. Calculating Vegetation Height 
To calculate vegeta�on height, you will create a raster file called a normalized Digital Surface Model or 
nDSM that shows the height of features above the ground. Previously, you created two raster files -- 
the DEM which shows the ground eleva�on, and the DSM which shows the eleva�on of features on top 
of the ground. You will subtract the values in the DEM from the values in the DSM to create a nDSM.  

1) In the geoprocessing pane, click the back arrow to return to the search bar.  
Type the word “Minus” into the Find Tools search bar. 

2) Click the Minus (3D Analyst) tool to 
open it 

3) Under Input Raster or constant 
value 1 select ArroyoSeco_DSM 

4) Under Input Raster or constant 
value 2 select ArroyoSeco_DEM 

5) Name your output raster: 
ArroyoSeco_nDSM 

6) Click Run 
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7) Go to the Symbology pane on the right side of your ArcGIS Pro window, by toggling to the tab at 
the botom of the Geoprocessing pane. 

8) Under Primary Symbology change the type to 
“Classify” 

9) Keep the default (Natural Breaks, 5 Classes) 
10) From the drop down menu choose this color 

ramp: 

 

 

 
  

 

The following image represents vegeta�on height. The dark green areas are the shortest features, 
including areas with bare ground. The bright red areas indicate the tallest trees. Zoom into the image 
and click different trees to find out their heights. All heights are in meters. 

 

 

11. Be sure to save your Project   
      Look at the top menu and click on Save 
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Part 5. Calculating Canopy Density 
 

Forest canopy density is used as a variable in a number of environmental applica�ons, such as biomass 
es�ma�on, vegeta�on coverage, and biodiversity determina�on. Canopy density, or canopy cover, is 
the ra�o of vegeta�on to ground as seen from the air. 

The following are steps to calculate canopy density from LiDAR points. First, you need LiDAR that has 
been classified into ground returns (bare earth) versus non-ground returns. This type of point 
classifica�on is usually performed by your data provider. Secondly, you need to consider when the 
LiDAR was collected and the type of vegeta�on in the study area. If there are a lot of deciduous trees 
and the collec�on was performed during winter (leaf off), the density calcula�on is not going to work.   

The most effec�ve way to determine the canopy density is to divide the study area into many small 
equal-sized units through rasteriza�on. In each raster cell, you compare the number of above ground 
points to the total number of points. 

The important technique to remember here is to determine an appropriate cellsize for this analysis. It 
needs to be at least four �mes the average point spacing. You can go larger but not smaller with the cell 
size. 

Part A)  Classify LAS by Height  

You have already classified buildings in our point cloud, our next goal is to classify our point cloud by 
height above ground.  

1) Click once on your ArroyoSeco.lasd file in the contents pane to enable the LAS Dataset Layers 
at the top Menu.  

2) Click on Classifica�on Tab and then click on the drop down arrow for Automated Classifica�on 
and select Classify by Height. 
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3) Under Input LAS Dataset choose 
ArroyoSeco.lasd from the drop down 
menu  
Change the Height values to 0.5, 2 , 50  
(these values are in meters), leave the 
height classifica�on codes as they are. 
 

These settings will classify the lidar; Code 3 – 
Low vegetation points from 0 - 0.5 meters,  
Code- 4, Medium Vegetation points from 0.5 
to 2 meters, Code 5 High vegetation from 2 
to 50 meters. See Classification Table below. 
 

4) Check Compute Sta�s�cs   
5) Then check RUN.  
6) Note - This process only classifies 

unassigned points (Classifica�on Code 1) 
so the buildings class (Code 6) will not be 
changed. 
 
For more informa�on the Classifica�ons Codes 1-6 are: 

Classifica�on Value Meaning 
0 Never Classified 
1 Unassigned 
2 Ground 
3 Low Vegeta�on 
4 Medium Vegeta�on 
5 High Vegeta�on 
6 Building 

 
Since we have changed the classifica�on we need to refresh 
our data values before we display them.  The best way to do 
this is to remove our ArroyoSeco.lasd and then re-add it to 
our Contents Pane.   

7) From the Contents Pane,  Right Click on the 
ArroyoSeco.lasd file and then select Remove. 

8) Now go back to the Catalog Pane and add that same 
ArroyoSeco.lasd file to your map.  If you cannot find 
it be sure to look in your 
C:\Student\Exercise_Data\Arroyo_Seco_Data folder.  
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Now you will look to see how the points were classified.  Since you are only interested in tree canopy 
you let’s display only Classifica�on Code Values 4 and 5:  Medium and High Vegeta�on 

 

9) From the LAS Dataset Layer 
menu click on  Appearance 
and under filters select  
 Surface Constraints 

 

 

10) Then select LAS Filter:  And 
only check Medium and High 
Vegeta�on to be displayed.  
Then click OK. 

 

 

 

 

 

 

11) To view the difference between 
the two classes, open the 
Symbology Pane and select Draw 
points using Classifica�on.    
 
 
 

12) Turn on the Ortho2016.img and compare the imagery with the point cloud.  Zoom in and you 
will no�ce more detail with the LiDAR points.    
For the classifica�on, only unassigned points were classified by height, buildings were not 
reclassified and so they were le� out.  NOTE: There may be some buildings missed by our 
buildings footprints shapefile and those would be mistakenly classified as high vegeta�on.   
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Part B) Convert Medium and High Vegetation LiDAR points to a Raster 
 

At the end of Part A you filtered our LAS points to only view classifica�on codes 4 and 5, 
(Medium and High Vegeta�on). You will now convert only those points to raster.  
 

1) In the geoprocessing pane, enter 
 “LAS Point Sta�s�cs as Raster” in 
the Find Tools search bar.”  

2) Click LAS Point Sta�s�cs as Raster to 
open the tool. 

3) Under Input LAS Dataset choose 
ArroyoSeco.lasd from the drop 
down menu  

4) Change the name of the output file 
to Count_Veg.  

5) Change the Method to Point Count 
6) Change the Sampling Value to 1. 
7) Click Run  

 
 
 
If you look at the results of Count_Veg, you will no�ce no data values.  You need to fix this raster 
so that no data has a value in order to determine percentage of canopy.  
 

8) In the geoprocessing pane, click on the back 
buton to get to Find Tools, enter 
 “Is Null” in the Find Tools search bar.”  
 
 

9) Set the Input Raster as Count_Veg and the 
Output Raster as ISnull_Veg 

10) Click Run.  

 

Look at the results of ISnull_veg.  The values are opposite what we need to run our analysis.   
Canopy is 0 and no canopy is 1, so to fix this we will use the reclassify tool. 
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11) In the geoprocessing pane, click on the 
back buton to get to Find Tools, enter 
 “Reclassify” in the Find Tools search 
bar.”  

12) For input raster ISnull_veg 
13)  Reclass field is Value 
14) Then under New type 1, 0  
15) Output raster : Reclass_ISnull 
16) Then click RUN. 

 

Now when you view Reclass_ISnul you will see 
that canopy now has a value of 1 and no 
canopy has a value of 0.  (you can look at 
Ortho2016.img to compare where there is 
canopy).  

 

Part C) Calculate Percent Canopy Density 

One way to determine canopy density is to divide the study 
area into many equal-sized units and then compare the 
number of canopy pixels with non-canopy pixels.  In this 
next step, you will do this by crea�ng a regular sized 5x5 
meter vector la�ce and then running a command using 
Zonal Sta�s�cs.   

1)  To create a la�ce from which you will summarize 
our canopy cover use the Fishnet command. 

2) In the geoprocessing pane, click on the back buton 
to get to Find Tools, enter 
 “Create Fishnet” in the Find Tools search bar.”  

3) For in output feature class enter ‘fishnet’ 
4) For Template Extent click on As Specified Below and 

choose Same as Layer Count_Veg. This will populate 
the extent se�ngs. 

5) For Cell Size Width enter 5 
6) For Cell Size Height enter 5  
7) For Geometry Type select Polygon 
8) Then click RUN. 
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In your map you will now see the 5x5 meter grid.  Our next step is to summarize the number of canopy 
pixels within each 5x5 meter area. 

9) In the geoprocessing pane, click on the 
back buton to get to Find Tools, enter 
“Zonal Sta�s�cs” in the Find Tools 
search bar.”  

10) Input feature zone data select your 
fishnet layer  

11) Choose the zone field OID 
12) Input value raster: Reclass_ISnull 
13) Name your output raster 

Zonal_Canopy 
14) Sta�s�cs Type:  SUM 
15)  Then click RUN. 

 

The Zonal Canopy Results will appear in your map.  No�ce 
that the highest value is 25. Since we were coun�ng the 
number of 1 meter pixels in a 5x5 meter grid the highest total 
or 100% canopy is 25. To scale this to range from 0-100% we 
need to mul�ply these values by 4.     

 
16) In the geoprocessing pane, click on the back 

buton to get to Find Tools, enter 
“Raster Calculator” in the Find Tools  
search bar.”  
 

17)  Once Raster calculator is open, double click 
on the Raster Zonal_Canopy so that it 
appears in the box below.  Then double click 
on the mul�plica�on symbol and then type 
in 4. 

18) Name the output raster Percent_Canopy  
19) Then click RUN. 

  
You now should have your Percent Canopy 
Raster that totals 100. 
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20) Now Change the Symbology so your Percent Canopy is classified 

using 5 classes and use a green (Con�nuous) color ramp 
 

21) Type in the Class Breaks Upper 
Values to  
0 , 25, 50, 75, 100   
You can type directly on the 
number to change the values 

 

 

 

Your image should look similar to the image below.  

 

 

 

 

 

 

 

 

 

 

22) Click the image in different areas to view the percent canopy.  
 Just use your mouse and click on the image to see values of percent canopy.  

23) Be sure to save your project before going on to the 
next sec�on. 
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Part 6. Design a Map Layout 
Now that you have created mul�ple LiDAR products, let’s design a map that can provide useful 
informa�on in a tradi�onal map layout format.  You will design a map showing vegeta�on height.   

1. Before you create our map remove all  layers from your table of contents EXCEPT for  
a. DEM : ArroyoSeco_DEM 
b. DEM Hillshade:  ArroyoSeco_DEM_hs 
c. Vegeta�on Height:   ArroyoSeco_nDSM 

   To remove layers from your view, right click on         
               your data layer and select ‘Remove’ 

 

2. Turn on ArroyoSeco_nDSM to see your map to view 
above ground height values.  These values are in meters 
and you are interested in only looking at the tall trees.    
Click on Symbology and select Classify 
 

3. Change the number of classes to two.  
 
4. Manually enter the Upper Values and Label as 
shown below.  For the first class type 14.9 and the 
second class type 50 in the Upper Value box. The first 
class represents areas between 0-14.9 meters, the 
second class represents areas between 15-50 meters.  
Click on the color box and select No Color.  On the 
second class leave the color as red and then type in the 
label ‘Trees Greater than 50 Feet’ (as 15 meters = 
approximately 50 feet).  Make sure this class is red. 
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5. Now you should see in your map only Trees Greater than 50 feet as red with your other 
vegeta�on heights less than 50 feet will be transparent.  
 

6. Turn on your DEM Hillshade:  
ArroyoSeco_DEM_hs and 
leave the symbology 
stretched and grey scale.  
 

 
7. Within your Contents Pane make sure your Layers 
are arranged in the following order as shown on the le�. 
 
8. Now for your DEM: arroyoseco_DEM make sure 
your layer is turned on and choose the following Color 
Scheme Eleva�on #1.  At the botom of the menu you can 
click ‘Show Names’ to see the names for the Color 
Schemes.  

 

 
 
 
 
 
 
 
 
 
 
 

 
9. Next, Click on Arroyoseco_DEM once to select it and then from the top menu, Raster Layer / 

Appearance  menu click on the transparency Slider and go to 50%  
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10. Now that our layers look that way we want them, it is 
now �me to put them into a map layout.   
From the top menu click on Insert / New Layout and 
then select ANSI Leter – Landscape 8.5x11 

 

 

 

 

 

11.  This will open a blank layout and then you need to 
insert the map frame with our data.  From the top 
menu select Insert / Map Frame and select your map. 

 

 

 

 

 

 

 

 

 

 

12.   Now your cursor will show a rectangle shape, click and hold to draw a box on the page where 
you want your map to be placed. Now you should see the map in your view.   
 



Lidar Derived Products: Part B 

 

Page 24 

13. It may not look centered in your frame so go back to 
your Contents pane and click to Expand the Map 
Frame contents to see all the layers.  Right click on 
arroyoseco_Dem and select Zoom To Layer.  
 
 

14. With The Insert Menu s�ll open you should 
see other features you can add to your map. Find 
North Arrow tool and click on the drop down arrow.  
Pick the style you would like and click on the map 
and it will paste the north arrow in that loca�on. 

 

 

15. Now add a Scale Bar. Click on the Scale Bar tool just 
next to the North Arrow tool.  Once you have the scale 
bar on your map right click on the scale bar and then 
click on proper�es.  This will bring up a window so you 

can format your scale 
bar.   
-Change the map units and Label Text to Feet.  
-Change the Resize Behavior under Divisions to “Adjust number 
of Divisions” 
- Change the division value to 500 

 

 

16. Next let’s add a �tle to our map.   Click on Text and then 
select the simple text as shown below.  Click at the top center 
of your map to place the text.  
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17. This will create a text box on your map and should also 
bring up the Format Text window where you can enter 
your text.  Enter something similar as to what is here:  
 
 
 

18.  To increase the size of the text and to change the font.  
Click on the text box and go to the top menu  
Text and then Format 

 

 

 

 

 

 

19. To navigate around your layout from to top 
click on Layout / Navigate  to pan around 
To select features click on Select.   
 
 
 
 

20. Next you will insert a legend.  You will add the trees greater than 50 feet to a legend. Click once 
to highlight Arroyo_Seco_nDSM in your Contents Pane.   Then from the top menu select Insert / 
Legend then click on your map where you would like to up your legend.  It will then create a 
legend for the item you highlighted in the Contents Pane.   
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21. Since you don’t need all of the informa�on in the 
legend, such as layer name, you will convert it to 
a graphic and edit.  Right Click on the legend and 
then select Convert to Graphic.   
 

22. Then right click on the legend and select 
Ungroup. Now you can remove everything but 
the red color box and ‘Trees Greater than 50 
feet’.  Select the item you want to delete and 
then hit the delete key.  

 

23. Finally you will add source informa�on to our map.  Insert another text box and add the 
following informa�on:   Source Informa�on:  2016 LiDAR from the US Geological Survey.  Choose 
a smaller font and put in either the lower right or lower le� corner.   Also add your name and 
date in the botom corner. 
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24. Now save your project one more �me.  
 
 
 

 

 
25. Lastly you will convert our map to a PDF.  From the top menu select Share/Layout/ Export. 

 

 

 

 

 

 

 

26.  Give your file a name and save as  PDF with 300 dpi resolu�on.  Output as Image.  Save this in 
your student folder.  Open the file to look at your final product.  

 
 

This is the end of Exercise Part B and  
you are �inished with the LiDAR workshop.  
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